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Me

e Software architect on Sirius Web

* 15 years of contribution in the Sirius ecosystem

e Acceleo
e EEF
* Sirius Desktop

e Sirius Web
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Sirius Web
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& ® )X Sirius Web X o+ ~

< C ® localhost:5173/projects/cdf5f15b-0ebf-429a-b8bf-73c84e6791b8/edit/c0427a3¢c-52b0-4b33-ab7d-a9f0f97c74fd?selection=6d748870-4c3f-4597-ac92-ff9b973885b8
)2( Papaya - Example : > RUN COMMANDS...
Sirius Web internal test project
.|= *1& Explorer () Project Creation Lifecycle Diagram X = Details
+ % & ' SemanticDataCreatedEvent
TR Ay BERXTOCREN T
> Tasirius Core Properties

v E: Sirius Web - Lifecycle
v {aY Sirius Web

Name ()

SemanticDataCreatedEvent

£3 HTTP
v 3 Project Creation oo
[ | Description
() Project Creation Lifecycle Diagram
v ¢ MutationCreateProjectDataFetcher ’
. . &8 HTTP
-0 CreateProjectlnput over HTTP Emitted By
@ IProjectApplicationService y P —
O- SemanticDataCreatedEvent over null © & Values e 4+ B -
> @ SemanticDatalnitializer
> @ ProjectSemanticDatalnitializer i ook G Listened By
e . X channel e —
@u CreateProjectinput  : ) -0 SemanticDataCreatedEvent over null . Valie e 4+ B -
pplication Layer
> Og Project
i Caused B
v Qs Semantic Data ,
> (© ISemanticDataCreationService Fo ProjectCreatedEvent (3 Valucs “ + W ¥
5 . 8% CreateProjectinput | | & MutationCreateProjectDataFetch
o SemanticDataCreatedEvent  : R listened by ’ HeneRer e e
> s Project Semantic Data
call
@ IProjectApplicationService @ SemanticDatalnitializer | @ ProjectSemanticDatalnitializer
N| -
call call a
L3 Domain Layer
23 Ploject RS :‘vv\‘\’wh“[ln' Qs Project 53;"*,1"‘«’ Data
@ IProjectCreationService @ ISemanticDataCreationService © IProjectSemanticDataCreationService
emits ’— listened|by Jemils [—‘ listened|by lemds
e o 5

Learn more

Follow these links to view the code of this
Sirius Web internal test project on Github.

« Backend code
» Frontend code

v  OBEO



Sirius Web

* Open source project of the Eclipse Foundation

 Web based modeling workbench

* Define your concepts

* Specify how to view and manipulate them

« Start working #

s OBEO
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E( Sirius Web

C ® localhost:5173/projects/0645ebcc-4455-4858-9b67-4ca264799de3/edit/d7db0110-7aca-4a9e-9898-d5149d60efa9?selection=9e60a5f6-0790-4f9d-baba-b32dalfaacd5

N

®8 Explorer

v = Domain
v & franklin
‘!* Domain

v [ Project
name
description
-> applicationConcerns
- domains
-> iterations

v [C] ApplicationConcern
name
-» services
-> controllers

v [] service
name

v [] Controller
name

v [] bomain
name
- services

v [] iteration
name
done

> = View

X

o+

o
LJ

Studio :

i'i Domain X

Doa<MyBEEXETCR@EN T

3 Project

name
description

applicationConcerns [0..%]

[ ApplicationConcern
name

domains [0..%]

) Domain

[A] name

controllers [0..*] services [0..*] services [0.."]
, A 2
3 Controller ¢ O Service :I:
@& name namev r IR
Q, Searcl
< Entity
Text
Boolean
(1] Number

iterations [0..*]

O lteration

name
done

= Details

Service

Core Properties

Name

Service

> RUN COMMANDS...

Super Types

11U

[] Abstract

=

v  OBEO



Bivi@it- 0@

=z [# Package Explorer X

|:)3 ContainingLink.java
L?g Contribution.java
I_?g Controller.java
Dg DataType.java
|_73 Domain.java
I?g Enum.java
D’g EnumLiteral.java
L?S Event.java
Dé‘ Folder.java
Dg FolderElement.java
[B GenericType.java
D'g Interface.java
Ug Interfacelmplementation.java
|_73 Iteration.java
Dg Link.java
D‘g Message.java
]?3 MessageEmitter.java
[_?3 Messagelistener.java
Dg ModelElement.java
|_?3 NamedElement.java
L]g Operation.java
I_!g OperationalActivity.java
[_73 OperationalActor.java
I?g OperationalCapability.java
I?g OperationalEntity.java
[)3 Operationalinteraction.java
OperationalProcess.java
I_Té‘ Package.java
D‘g PapayaFactory.java
D'g PapayaPackage.java
Efg Parameter.java
Dg Priority.java
Ef'g Project.java
DS ProvidedService.java
I?g Publication.java
Dg Query.java
I—!g Record.java
Dg RecordComponent.java
I?g ReferencingLink.java
l_?g Repository.java
I_?g RequiredService.java
L?g Service.java
D'g Subscription.java
I?g Tag.java
E@ Task.java
Dg Type.java
L]'g TypedElement.java
I?S TypeParameter.java
[ visibility.java
H% org.eclipse.sirius.components.papaya.impl
E% org.eclipse.sirius.components.papaya.spec
Hg org.eclipse.sirius.components.papaya.spec.derived
Eﬁ org.eclipse.sirius.components.papaya.util
v Q% src/main/resources
v [y model
i papaya.ecore
[t papaya.genmodel
=\ JRE System Library [JavaSE-17]
=\ Maven Dependencies
{#% src/testfjava
@target/generated-sourceslannotations
(#% src/test/resources
& target/generated-test-sources/test-annotations
[ src
= target
s} pom.xml
E:d pom.xml.versionsBackup
@ sirius-components-papaya.iml

VvV V V V V V V V V V V V V V V VV V VVVV VYV VYV YV VYV VLV VYV VYV VYV VLV VVVYVYVYVVYVYVYVYV

vV VvV VvV VvV

> Hsirius-components-papaya-edit [sirius-web sbe/enh/papaya-fix]

Selected Object: Project -> NamedElement, Container

2 M CA- = AF

spring-tools-for-eclipse - sirius-components-papaya/src/mainfresources/model/papaya.ecore - Spring Tools for Eclipse

M@ B

ES 8§ = O

C_] papaya.ecore X @ papaya.genmodel
v i_l platform:/resource/sirius-components-papaya/src/main/resources/model/papaya.ecore
v papaya

> E| ModelElement

> HTag

> [ Link

> ReferencingLink -> Link

> [ ContainingLink -> Link

> k] NamedElement -> ModelElement

> [ Container

|5 Folder -> NamedElement, Container
[] FolderElement

> B Project -> NamedElement, Container

> [ OperationalCapability -> NamedElement, FolderElement

E} OperationalEntity -> NamedElement, FolderElement
> [ OperationalActor -> NamedElement, FolderElement

|-} OperationalProcess -> NamedElement, FolderElement
> [ OperationalActivity -> NamedElement, FolderElement

> [ Operationalinteraction -> NamedElement

1 Instant [java.time.Instant]
> [ Iteration -> NamedElement, FolderElement
> [ Task -> NamedElement, FolderElement
> 2 Priority
Contribution -> NamedElement, FolderElement
Component -> NamedElement, FolderElement
ComponentPort -> NamedElement
ComponentExchange -> NamedElement
ProvidedService -> NamedElement
RequiredService -> NamedElement
Visibility
AnnotableElement

Type -> NamedElement, AnnotableElement
TypedElement -> NamedElement, AnnotableElement
GenericType -> ModelElement, AnnotableElement
Annotation -> Type
AnnotationField -> TypedElement
Classifier -> Type
TypeParameter -> NamedElement
Interface -> Classifier
| Interfacelmplementation
Class -> Classifier, Interfacelmplementation
Constructor -> AnnotableElement
—| Attribute -> TypedElement
[£] Operation -> TypedElement
[l Parameter -> TypedElement
> E} Record -> Classifier, Interfacelmplementation
Ej RecordComponent -> TypedElement
[ DataType -> Type
> [ Enum -> Type
|-} EnumLiteral -> NamedElement, AnnotableElement

|

vV V V V V VV VVV V V.YV
o
¢

(I 0D 0D 0T 07 00 00 00 00 01 01 0D 00 00w

v

>
>
>
>
>
>

> E} ApplicationConcern -> NamedElement, FolderElement
[ Controller -> NamedElement, MessageEmitter, MessagelListener

>
> [ Domain -> NamedElement, FolderElement
>

E] Service -> NamedElement, MessagelListener, MessageEmitter

LQ Problems @ Javadoc @ Declaration L’??J Git Repositories [_| Properties X

Property Value
Abstract v false
Default Value =
ESuper Types £l NamedElement -> ModelElement, Container
Instance Type Name '=
Interface lv false
Name 1= Project

: | OZ

hifl] B

og

Package -> NamedElement, AnnotableElement, FolderElement

elele}

%.. OBEO



® 0 ® )X Sirius Web X 4+
< C ® localhost:5173/projects/0645ebcc-4455-4858-9b67-4ca264799de3/edit/d7db0110-7aca-4a9e-9898-d5149d60efa9?selection=bc203f07-9bf6-4d18-bf53-d267bd0901ca
X Studio
BN "3 Explorer & Domain X
T
tHEHa A< Ay BXETOCREN T
> ‘= Domain
v E:View
v © View
g v & Diagram
> £ DiagramPalette
> [5] Application Concern Node
> [5] Domain Node
> €D ColorPalette
O Project
name
description

T

iterations [0..*]

[A] name

controllers [0..*]

[ Controller

name

applicationConcerns [0..%] domains [0..*]
[ ApplicationConcern ) Domain
name name
services [0..*] services [0..7]
[ Service
name

> RUN COMMANDS...

= Details
Diagram

Core Properties

Name

Diagram

Domain Type

franklin::Project

Precondition Expression

Title Expression

Diagram

Icon Expression

N Express

[] Auto Layout

Arrange Layout Direction
@® UNDEFINED () RIGHT (O DOWN

O Lerr Q upP

=

v  OBEO



© ® 1:‘( Sirius Web

é

"=

> C ® localhost:5173/projects/0645ebcc-4455-4858-9b67-4ca264799de3/edit/d7db0110-7aca-4a9e-9898-d5149d60efa9?selection=fe690bb4-56¢c2-4c08-b594-82e1374985¢c6

)E(

®® Explorer

> E: Domain
v = View
v © View
v g Diagram
> &= DiagramPalette
> [Z] Application Concern Node
> [] Domain Node
> @ ColorPalette

X

+

ﬁ Domain X

nhe e My

Studio

HXx"mMOCRGEWNT

3 Project

name
description

T

iterations [0..*]

O ApplicationConcern
name

applicationConcerns [0..*]

domains [0..*]

[ Domain

name

] Controller
name

controllers [0..*]

services [0..*]

] Service
name

services [0..*]

O] Iteration

name
done

React Flow

> RUN COMMANDS...

— Details

Application Concern Node

Core Properties

Name

Application Concern Node

Domain Type

franklin::ApplicationConcern

Semantic Candidates Expression

aql:self.applicationConcerns

Precondition Expression

Precondition Expression

Synchronization Policy

® SYNCHRONIZED () UNSYNCHRONIZED

[7] collapsible

Reused Child Node Descriptions

Values e 'i
Reused Border Node Descriptions

Values e i
User Resizable

@® BOTH (O HORIZONTAL (O VERTICAL () NONE

Default Width Expression

Default Width Expression

Default Height Expression

Default Height Expression

[[] Keep Aspect Ratio

Is Collapsed By Default Expression

Is Collapsed By Default Expression

Is Hidden By Default Expression

Is Hidden By Default Expression

Is Faded By Default Expression

Is Faded By Default Expression

"% OBEO



L Sirius Web X + v

& C ® localhost:5173/projects/0645ebcc-4455-4858-9b67-4ca264799de3/edit/d7db0110-7aca-4a9e-9898-d5149d60efa9?selection=fe690bb4-56¢c2-4c08-b594-82e1374985¢c6 W ) 0
Studio @ > RUN COMMANDS...
*I& "3 Explorer & Domain X = Details =
+ ? 3 .1: e Application Concern Node
C C)\ O\, @:: N Vv @ EFLNZ i[g q\% @ @ @ -
> g Domain Core Properties
v E:V|ew : -
v © View
s 2 Diageam Application Concern Node

> £ DiagramPalette Domain Type

> [5] Application Concern Node

> [ Domain Nod franklin::ApplicationConcern
omain Noae

Semantic Candidates Expression
aql:self.applicationConcerns
[ Project
o — Application Concern Node
description
description
J I ! Domain Type
Concerns [0..%] domains [0..*] . i .
l franklin::ApplicationConcern
applicationConcerns [0..*] domg E3.Domaln
name
Semantic Candidates Expression
v :
. [0..7] services [0..%]
l name
L Default Height Expression
[ Service
— A name

[ ] Keep Aspect Ratio

Is Collapsed By Default Expression
Is Hidden By Default Expression

Is Faded By Default Expression

v OBEO



® 0 ® )X Sirius Web X 4+
< C @® localhost:5173/projects/69a30c3e-50b0-4460-8845-34d1a5¢3f088/edit/da8b0df6-6c16-4c85-89b1-808ead4127a0?selection=73b6ab3d-f3¢c3-4349-bd20-cf0aad43d42ch
)2( Instance
"% ™& Explorer & Diagram X
+ ¥ &
cBEAA<<AyBEXTCREWN T
v = Others...
v < Sirius Web
‘!*Diagram

v < Project Creation

<4 |ProjectApplicationService

> < Project

Project Creation

IProjectApplicationService

Project

IProjectCreationService IProjectSearchService

= Details

IProjectApplicationService

Core Properties

Name

IProjectApplicationService

> RUN COMMANDS...

=



& ® )X Sirius Web X o+ ~

< C ® localhost:5173/projects/cdf5f15b-0ebf-429a-b8bf-73c84e6791b8/edit/c0427a3¢c-52b0-4b33-ab7d-a9f0f97c74fd?selection=6d748870-4c3f-4597-ac92-ff9b973885b8
)2( Papaya - Example : > RUN COMMANDS...
Sirius Web internal test project
.|= *1& Explorer () Project Creation Lifecycle Diagram X = Details
+ % & ' SemanticDataCreatedEvent
TR Ay BERXTOCREN T
> Tasirius Core Properties

v E: Sirius Web - Lifecycle
v {aY Sirius Web

Name ()

SemanticDataCreatedEvent

£3 HTTP
v 3 Project Creation oo
[ | Description
() Project Creation Lifecycle Diagram
v ¢ MutationCreateProjectDataFetcher ’
. . &8 HTTP
-0 CreateProjectlnput over HTTP Emitted By
@ IProjectApplicationService y P —
O- SemanticDataCreatedEvent over null © & Values e 4+ B -
> @ SemanticDatalnitializer
> @ ProjectSemanticDatalnitializer i ook G Listened By
e . X channel e —
@u CreateProjectinput  : ) -0 SemanticDataCreatedEvent over null . Valie e 4+ B -
pplication Layer
> Og Project
i Caused B
v Qs Semantic Data ,
> (© ISemanticDataCreationService Fo ProjectCreatedEvent (3 Valucs “ + W ¥
5 . 8% CreateProjectinput | | & MutationCreateProjectDataFetch
o SemanticDataCreatedEvent  : R listened by ’ HeneRer e e
> s Project Semantic Data
call
@ IProjectApplicationService @ SemanticDatalnitializer | @ ProjectSemanticDatalnitializer
N| -
call call a
L3 Domain Layer
23 Ploject RS :‘vv\‘\’wh“[ln' Qs Project 53;"*,1"‘«’ Data
@ IProjectCreationService @ ISemanticDataCreationService © IProjectSemanticDataCreationService
emits ’— listened|by Jemils [—‘ listened|by lemds
e o 5

Learn more

Follow these links to view the code of this
Sirius Web internal test project on Github.

« Backend code
» Frontend code

v  OBEO



Sirius Web X -+

C @ localhost:5173/projects/38b602a5-eb2d-4e01-b6b0-17bf89e1b21b/edit/ad2285da-a8b9-45e2-be05-8df37699de8d

E( Pokemon

"% ™3 Explorer New Representation X = Details

+ ¥ & THA<MEETSE N Ash Ketchum L@

v ‘Pa Pokemon : Core Properties (<>
v &4 Pokemon Game Name

a2 New Representation
> @ Kanto
> @ Kalos
v A Ash Ketchum
B Pokedex
€ Pokeball
> & Water / Fire / Grass
> & Electric / Poison / Normal
v & Gary Oak
B Pokedex
® pokeball
> &) Awesome Team!
v & John
B Pokedex
5 @ Toam | @ Awesome Team! | B Pokedex of Ash Ketchum

@ 1 - Bulbasaur
@ Bulbasaur

Ash Ketchum

I ( &
== Viridian City == Cerulean City V= 7 . ) - == Lumiose City || == Santalune City

B FPokedex of John

Pokedex of John % 52 - Meowth

John

& 4 - Charmander
& 7 - Squirtie

¥ 69 - Bellsprout
YW 25 - Pikachu

W 41-Zubat

' 19 - Rattata

(%) Ivysaur

(% Venusaur

& Charmander

h Gary Oak Mankey c

Awesome Team!
P A S SR,

(3 Charmeleon

Pokedex of Ash Ketchum

(% Charizard

¢ Squirtle

& Water / Fire / Grass

O& &

Bulbasaur Charmander Squirtle

(3 Wartortle

Water / Fire / Grass

() Blastoise i Giary Onl ! ¢
| Pokedex of Gary Oat
¥ Caterpie !

B FPokedex of Gary Dak

(» Metapod o commmeer | | 000 e
s 54 - Psyduck

PO : 56 - Manke:
(s Butterfree : W 63 - Abra v Ash KNG / Paison / Normal
(3 Weedle :

(3 Kakuna : AR e ; N\ 7%

Bellsprout

(%) Beedrill
& Pidgey
(3 Pidgeotto  : /7

| Ash Ketchum

¢ Electric / Poison / Normal

(3 Pidgeot
& Rattata

\_)) Raticate Pikachu Zubat
(s Spearow

() Fearow

(s Ekans

Raftata

(% Arbok

i3 Pikachu

\_)) Raichu React Flow

%  OBEO



Sirius Web

Sirius Web comes with various representations
 Diagrams

* Forms

* Trees

e Gantt

* Deck

* Portal

e Table

s OBEO
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® 0 ® )X Sirius Web X 4+

€ c 0

INg

BN "3 Explorer

v ‘= Sirius

v (o) Sirius Web

(@ Milestone Planning Example

@ Planning Example

> [ Operational Analysis
v [ Tasks

[4946] Add a loading indicator for publishing a library

[5015] Add the ability to duplicate projects

[5044] Add new options to manage the appearance of rectangular |
[5047] Add support for the customization of the appearance of edg:
[5045] Add support for the customization of the appearance of imat

[5046] Add new options to manage the appearance of labels

<

[5073] Improve support for read only objects in the details view
[5007] Add the ability to use an alternate interpreter in the query vit
[4921] Improve the content of the SBOM

[5060] Decouple the invocation of tools from the palette
[4756] Add a first support for the customization of the appearance
[releng] Switch to Spring Boot 3.5.0

[releng] Switch to Spring Boot 3.4.3

<

[releng] Switch to Spring Boot 3.4.4
[releng] Switch to Spring Boot 3.4.5
[4098] Cache the AQL services for a given metamodel

[cleanup] Remove the dependency to Guava in sirius-components-

[releng] Switch to JaCoCo 0.8.13

[4846] Avoid a database access if not necessary

[3993] Use material-react-table for the project browser

[5051] Lower our dependency to XState

[5024] Add the ability to support images computed dynamically

> [ lterations

localhost:5173/projects/c62bd387-c202-4583-b6a3-df1b92b2b911/edit/913ff71b-7fc7-4d58-b603-b8b7bc34e853?selection=7747d4ac-15d7-41fd-88¢c2-25b910266646

Papaya - Example :

Sirius Web internal test project

(@ Planning Example X

£ SETTINGS
A
Name
4946 [4946] Add a loading indicator for publishing a library
5015 [5015] Add the ability to duplicate projects
5044 [5044] Add new options to manage the appearance of rectangular nodes
5047 [5047] Add support for the customization of the appearance of edges
5045 [5045] Add support for the customization of the appearance of image nodes

P3

P1

P2

P1

P2

B
Priority

Cost

Done

true

false

false

false

false

Rows per page:

> RUN COMMANDS...

5

b A4

Actions

.
.
.

|]

(o

v  OBEO



Sirius Web Tables

 Manipulate large set of data

e Same principles as other representations
 No hypothesis on the shape of your concepts
 Parameterized by a description
* Synchronized with your data

 Updated in real time

s OBEO



Sirius Web Tables

* [able description

e View DSL in the browser
 View builder API in Java

* Low level programmatic APl in Java

s OBEO



Sirius Web Tables

&« c @ localhost:5173/projects/fb982bd9-79d9-42ac-a0da-d2c2ea9ede5a/edit?selection=a448867e-2a71-4380-bc34-0e29ebed6a3b bre Im} o :

[ ) ® Y sirius Web X eE

Table Studio

"2 ™& Explorer = Details

Task Row
Create a new Model

v 'E: View i Select the model to create Core Properties
v © View Domain Name
v [@ Planning Example  : View r—
00 Name Column
00 Priority Column
00 Cost Column ») o0 SW sirius-web ¢ sbe/enh/papaya-fix SirilusWeb Tests
00 Done ~ : Create a new Representation N
= TaskRow : ; Select the representation to create (3 © PlanningTableDescriptionProviderjava
v O NameCell = Portal o . ' @&
D CellLabelWidgetDescription » léa . t ir £ . g
v 0 Priority Cell  : — 3% % m
D CellLabelWidgetDescription ¢ Baut
v O CostCell : Open an existing Representation Q ©
D CellLabelWidgetDescription Select the representation to open public class PlanningTableDescriptionProvider implements IRepresentationDescriptionProvider { i
v 3 Done W
£ ) r |
A I public RepresentationDescription create(IColorProvider colorProvider) {
| return new TableBuilders().newTableDescription()
.name( val "Planning")
.titleExpression( ie: "Planning™)
.domainType( e "papaya::Project")

.columnDescriptions(
this.nameColumnDescription(), SNIUENED JeRt
this.priorityColumnDescription(),
this.costColumnDescription(),
this.doneColumnDescription() i {

der 4

)

.rowDescription(this,rowbescription())

.cellbescriptions( =
this.nameCellDescription(),
this.priorityCellDescription(), «tostring()) ©
this.costCellDescription(),
this.doneCellDescription()

)

.build();

private RowDescription rowDescription() {
return new TableBuilders().newRowDescription()
.headerLabelExpression( vaue "ag
.semanticCandidatesExpression( value: "agl
.build();

eaderLabel()")

inatedData(cursor,

eAllConte ()->filter(papaya::Task)->toPa

private ColumnDescription n columnbescription() {
return new TableBuilders().newColumnDescription()

.headerLabelExpression( vaue: "Na

w .semanticCandidatesExpression( v
)

.initialWidthExpression(
.build();

able.svg"))
8 private CellDescription nameCellDescription() {
return new TableBuilders().newCellDescription()

.preconditionExpression( s agl:columnTargetObject == 'Name'")

)

.valveExpression("agl:self.name
=) .cellWidgetDescription(
new TableBuilders().newCelllLabelWidgetDescription()
¢ .build()
%0 )
.build();]

packages sirius-web ba

D sirius-web-papaya [ nair ava g & 56 sirius web papaya epresentations planningtable ) PlanningTableDescriptionProvider ameCeliDe ptior 7 | -8 4 spaces [
184 return variableManager.get(VariableManager SELF, Object.class)

filter(Project.class::isInstance)

.isPresent();

private PaginatedData getSemanticElements(VariableManager variableManager) { age

var self = variableManager.get(VariableManager.SELF, EObject.class).orElse( other null);
var cursor = variableManager.get(TableRenderer.PAGINATION_CURSCR, EObject.class).orElse( otner null);

L; var direction = variableManager.get(TableRenderer.PAGINATION_DIRECTION, String.class).orElse( other: null);
var size = variableManager.get(TableRenderer.PAGINATION_SIZE, Integer.class).orElse( other @);

return new CursorBasedNavigationServices().collect(self, cursor, direction, size);

private List<ColumnDescription> getC
Map<EStructuralFeature, String> featureToDisplayName = this.getColumnsStructuralFeaturesDisplayName();







Pagination
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Pagination

e Server side pagination is compulsory for performance
 Need to render only what the end user Is asking

 More powerful semantic candidates expression

 PaginatedData instead of Collection

s OBEO
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Page n°4 with 5 rows per page?

v.. OBEO



Page n°4 with 5 rows per page?

% OBEO



Page n°4 with 5 rows per page?




Page n°4 with 5 rows per page?




Page n°4 with 5 rows per page!




g @O 6O © B G @ @& ® & &

% OBEO



Page based approach



Page based approach

* Quite easy to manipulate
e OFFSET & LIMIT

 Page n°4 with 5 objects per page -> n°16 to n°20

s OBEO



O 6 6 O 6 & O ®
O @ O @ @
@ @& & ®
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Node 16 to 207
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Cursor based approach
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Cursor based approach

Inspired by GraphQL relay and Spring Data among others
Give you the ability to write performant tables for large dataset
Navigate only on the necessary objects

Dedicated variables that need to be used (cursor, search, direction, etc)

s OBEO
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5 next rows after the cursor?

CUrsor

J C 0‘0 0‘ 0‘0‘0 On®

%  OBEO



5 next rows after the cursor?

CUrsor

J C C’C C’ O O 0O T

% OBEO



Pagination

Semantic Candidates Expression

aql:self.eAllContents()->filter(papaya::Task)->toPaginatedData(cursor, direction, size)

s OBEO



Pagination

CursorBasedNavigationServices.java ForwardTreelterator.java

00 . sirius-web 7 sbe/enh/papaya-fix v

public class CursorBasedNavigationServices {

public PaginatedData collect(EObject self, EObject cursor, String direction, int size) {

return this.collect(self, cursor, direction, size, object -> true);

public PaginatedData collect(EObject self, EObject cursor, String direction, int size, Predicate<EObject> fil
var rootEObject = self;
if (cursor != null) {
rootEObject = cursor;

}
boolean isPrevDirection = "PREV".equalsIgnoreCase(direction);
Iterator<EObject> iterator = new ForwardTreelterator(rootEObject, cursor == null, filterPredic

if (isPrevDirection) {

iterator = new BackwardTreeIterator(rootEObject, false, filterPredicate);

(9 siriusWeb Tests v [l .. : R & Q ©

public class ForwardTreeIterator implements Iterator<EObject> {

private final Predicate<EObject> filterPredicate;
private EObject rootEObject;

private boolean includeRoot;

private List<Iterator<EObject>> iterators;

private Iterator<EObject> nextPrunelterator;

private Iterator<EObject> nextRemovelterator;

public ForwardTreelterator(EObject rootEObject, boolean includeRoot, Predicate<EObject> filterPredicate) {
this.rootEObject = Objects.requireNonNull(rootEObject);

this.filterPredicate = Objects.requireNonNull(filterPredicate);
this.includeRoot = includeRoot && filterPredicate.test(rootEObject);

public class ForwardTreelterator implements Iterator<EObject>

if (isPrevDirection) {
Collections.reverse(result);

¥

boolean hasPreviousPage;

if (isPrevDirection) {
hasPreviousPage = iterator.hasNext();

} else {
hasPreviousPage = cursor != null;

}

boolean hasNextPage;

if (isPrevDirection) {

hasNextPage = true;

} else {
hasNextPage = count == size && iterator.hasNext();
}
return new PaginatedData(result, hasPreviousPage, hasNextPage, -1);
}
public PaginatedData (List<Object> objects, Object cursor, String direction, int size) {

List<Object> sublList = new ArraylList<>();
boolean hasPrevious = false;
boolean hasNext = false;

if (cursor != null) {
int cursorIndex = objects.index0f(cursor);
if (cursorIndex >= 0) {
if ("NEXT".equals(direction)) {
int startIndex = cursorIndex + 1;
int endIndex = Math.min(startIndex + size, objects.size());

} else {

hasNext = this.hasMoreElements();
}
if (!hasNext) {

hasNext = this.hasNextRelative();
}

return hasNext;

private boolean hasAnyElement() {
var iterator = this.getNextChild(this.rootEObject);
this.iterators = new ArraylList<>();
var hasNext = iterator.hasNext();
if (hasNext) {
this.iterators.add(iterator);
}

return hasNext;

private Iterator<EObject> getNextChild(EObject eObject) {
Iterator<EObject> nextChildIterator = null;

for (EObject child : eObject.eContents()) {
var nextMatchingEObject = this.findNextMatchingEObjectRecursive(child);
if (nextMatchingEObject != null) {
nextChildIterator = List.of(nextMatchingEObject).iterator();
break;
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Sirius Web Tables

e Edit with various widgets
* Textfield
* Checkbox
¢ Select

 Custom widget

s OBEO






Filtering

® 0 ® )X Sirius Web X + ol
€ C ® localhost:5173/projects/c62bd387-c202-4583-b6a3-df1b92b2b911/edit/fd8cbe2c-81bc-4a90-a3bb-859fc0e25141?selection=fd8cbe2c-81bc-4a90-a3bb-859fc0e25141 w ) Q
23 Papaya - Example @
Sirius Web internal test project
®® ™§ Explorer @ Planning Example X
+ £ >
£x SETTINGS Q_ appearance X I= XX m I
v ESirius : LQ
v 11} Sirius Web  : A B C D Actions P
Milestone Planning Example : Name Priority Cost Done

Planning Example

> [ Operational Analysis

> (D Tasks 5044 [5044] Add new options to manage the appearance of rectangular nodes P2 3 false
> [ lterations
5047 [5047] Add support for the customization of the appearance of edges P1 3 false
5045 [5045] Add support for the customization of the appearance of image nodes P2 3 false
5046 [5046] Add new options to manage the appearance of labels P1 2 false
4756 [4756] Add a first support for the customization of the appearance P1 0 true voe

Rows per page: 20 ~
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Sorting

® @ )X Sirius Web X il
< Cc @® localhost:5173/projects/c62bd387-c202-4583-b6a3-df1b92b2b911/edit/fd8cbe2c-81bc-4a90-a3bb-859fc0e251417selection=fd8cbe2c-81bc-4a90-a3bb-859fc0e25141 w 3 o :
)2.(. Papaya - Example : > RUN COMMA
Sirius Web internal test project
.|= ™8 Explorer [@ Planning Example X
+ T & >
£ SETTINGS Q, appearance X = = M I
b E Sirius : Sorted by Name descending @
v () Sirius Web  : A o B G D Actions S
[@ Milestone Planning Example  : Name = & Priority Cost Done

[@ Planning Example

> [ Operational Analysis 5047 [5047] Add support for the customization of the appearance of edges P1 3 false

> [ Tasks

> [ tterations  : 5046 [5046] Add new options to manage the appearance of labels P1 2 false
5045 [5045] Add support for the customization of the appearance of image nodes P2 3 false
5044 [5044] Add new options to manage the appearance of rectangular nodes P2 3 false
4756 [4756] Add a first support for the customization of the appearance P1 0 true

Rows perpage: 5 ~
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Sub Rows

®  ® X sirius Web X + v
< C @® localhost:5173/projects/c62bd387-c202-4583-b6a3-df1b92b2b911/edit/52421e4a-9¢29-4bfc-86ba-23158e4fdb3d?selection=34189e20-d388-4610-8c77-2aec624506ab * 3 ° :
)Z? Papaya - Example  : > RUN COMMANDS.
Sirlus Web internal test project
®® ™& Explorer @ Milestone Planning Example X
+ T & | 4
€2 SETTINGS Q I= = m I
v = Sirius L@
v {aY Sirius Web Name Done Actions P
Milestone Planning Example
@ Planning E I
N E v 0 B 2025.4.0 2025.4.0
> [ Operational Analysis
> [ Tasks
v [ tterations > 1 releng [releng] Switch to Spring Boot 3.4.3
5 2025.4.0
5] 2025.6.0
B 2025.8.0 v 2 B 20256.0 2025.6.0
> 3 4946 [4946] Add a loading indicator for publishing a library
> 4 4756 [4756] Add a first support for the customization of the appearance
> 6 releng [releng] Switch to Spring Boot 3.4.4
> 6 releng [releng] Switch to Spring Boot 3.4.5
> 7 4098 [4098] Cache the AQL services for a given metamodel
> 8 cleanup [cleanup] Remove the dependency to Guava in sirius-components-emf
> 9 releng [releng] Switch to JaCoCo 0.8.13
Rows per page: 10 ~ <>
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Sirius Web Tables

Display data in a tabular view

Edition with dedicated widget
Pagination

Edition

CSV export

Filtering

Sorting

Subrows

And more...
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Table within a form

® @ )X Sirius Web X + *
< C @ localhost:5173/projects/cdf5f15b-0ebf-429a-b8bf-73c84e6791b8/edit/f74be474-3bb1-4f96-9598-a6fcf460e4f5?selection=a743a474-84fa-47e7-aa8b-84694a76a950
27 Papaya - > RUN COMMANDS...
Sirius Web internal test project
®= ™3 Explorer &a Class diagram X = Details
& ? e Concept
CHa A< BAvEXMmMOCROEWNT
v ‘= Sirius Core Properties
v () Sirius Web  : Name
> [3 tterations
> BT Concept
> [:]Contnbutlons 3 Description
> Operational Analysi
[ Operational Analysis = T = = B I O S
v o Component
d!i class diagram Description
v @ Package
v g Concept /\ Visibility
Cg name 4 ? PUBLIC v
g description E Concept
> ESirius Web - Lifecycle [[] Abstract
Attributes [J Final
[] static

C¢ name
Cg description

< > Attributes

Additional Information

Q SETTINGS = = (1T} ra
Operations
Visibility Actions
name PUBLIC wee
@ & description PUBLIC
vV

Learn more

Follow these links to view the code of this
Sirius Web internal test project on Github.

+ Backend code
* Frontend code

s OBEO



Conclusion
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 Diagram
 Deck
* Gantt
* Portal
 Table
* Form

e Tree

Representations

s OBEO



Webinars

e El 3 Unlock the Power of Diagra X + v

“ C % youtube.com/watch?v=0Qrk8h1Hxgo % 3 = 0

1 YouTube

@ localhost:5173)pr

B CED:R00S

K E 3 Unleash the Potential of Gan' X + %

D~3¢ B

C B https://www.youtube.com/watch?v=W_1D32dGYz0

* YouTube

New Daily Representation

General

v & cEaaaq< Name

== Santalune City

+ Aacre !
T ;
P Bl o) 1553/ 5220 NSO Raramtes

Unlock the Power of Diagram Creation with Sirius Web | Webinar by Stéphane Bégaudeau | Obeo

:» VObje:;COIPg w he &h /> Share L Download

3¢ clip [] save

Dependencies

Assigned People
Assigned Teams

New Gantt

<3 Two Days

Unleash the Potential of Gantt, Deck and Portal Creation with Sirius Web | Stéphane Bégaudeau | Obeo
Sirius - Webi
"\ Obecoony) b2 G&p /> Share L Download 3¢ clip [l save et S ) e e X

663 subscribers Obeo_corp - 1/
— =2
5



Webinars

 Diagrams https.//www.youtube.com/watch?v=0QrK8h1Hxgo

e Gantt, Deck & Portal https://www.youtube.com/watch?v=W 1D3zdGYz0

 Product tour, roadmap...
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https://blog.obeosoft.com

[ ® ¥, Sirius Web 2025.4 - The offic X + v

< ¢ 25 blog.obeosoft.com/sirius-web-2025-4 A ) Q

Sirius Web 2025.4

We are pleased to announce that the 2025.4 release of is now available!
You can find the complete list of fixes, improvements and new features is available in the

In this blog post, we'll take a closer look at some of the major improvements and new features included in this release.

LIBRARY SUPPORT: REUSE AND SHARE MODELS ACROSS PROJECTS

After laying out the groundwork for this feature over the past few releases, we are excited to announce the first version of library
support in Sirius Web.

In a Sirius Web studio, you can now publish a library to share parts of your domain or view models.

Publish Studios

s OBEO



https://eclipse.dev/sirius/sirius-web.html

& ® LY Sirius | Sirius WebHome x + i
c 25 eclipse.dev/sirius/sirius-web.html #r 3 o

We

Sirius Desktop Sirius Web

'7 e o
+
Slrlus FEATURES  EXTENSIBILITY COMMUNITY  REFERENCES  RESOURCES [N/ EeT 1)

Central_Unit

EASILY CREATE AND
®  ® ) eclipse-sirius/sirius-web: Si' X+ DEPLOY GRAPH'CAL = § Extornal Unit
« C 2% agithub.com/eclipse-sirius/sirius-web STUD'OS To THE WEB _o m

O eclipse-sirius sirius-web An open-source low-code platform for defining custom web

applications that support your specific visual languages

Issues 699 Il Pullrequests 93 ) Discussions () Actions [I] Projects [1J Wiki 2 Security 141 |~ Insights

sirius-web rubii

master -

@ sbegaudeau [releng] Bump version t X scdeafd - 1 v E '
B .dependabot releng] Update the dabot configuration
= Graphically represent With a modern No Desktop Installation
-githu . . . .
and edit data cloud-based application Required
8 .vscode
Modeling studios It with Sirius Web support Your studios provide a modern UX and are Once de ed on a se

B doc the editing of your DSL using both your specific deployed on a web server us state-of-the-art your custom studio direc L

visual notation and native domain concepts technologies: Spring, React, PostgreSQL with no need for any specif sktop installation
BB integration-tests releng] Bump version to 20 ) GraphQL
B packages
B scripts
B vscode-extension

jus Web Product Tour: Low-Cod®
PRODUCT TOUR

irus WeBriQerijeie
.gitattributes [cleanup] it w eckout crif ¢ w2 M NUTES

[ .gitignore

The Low-code Solution fo
€ egting w "' ased

.npmrc

CHANGELOG.adoc

CONTRIBUTING Packages 273

DEPENDENCIES ler j st rt hec endencies IP 3 years ago N sirius-components-core
N sirius-components-diagrams
] Dockerrun.aws.json.template
M sirius-components-selection

) LICENSE freleng] Replace code with n sion, now part of Siriu...
1 NOTICE
Contributors 29
README.adoc
package-lock.json

] package.json

] settings.xml

] turbo.json [r e turbo to version 2.3.3 montr Languages
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How to get started?

Download Sirius Web and run it

e See https://qgithub.com/eclipse-sirius/sirius-web

Integrate parts of Sirius Web in your own application

Build a Sirius Web based application

s OBEO


https://github.com/eclipse-sirius/sirius-web

Obeo Enterprise for Sirius

® @ #" Obeo Enterprise For Sirius - = X + o

< C 25 obeosoft.com/en/products/obeo-enterprise-for-sirius g D o

"
., 5 O B E O SOLUTIONS PRODUCTS SERVICES RESOURCES COMPANY CAREERS CONTACT

"

Obeo Enterprise for Sirius Features References Contact us

Enterprise Collaboration
Enabler for Cloud-Native PRe = 23
Graphical Modeling N

Obeo Enterprise for Sirius brings enterprise-grade collaboration ' — £l ses *

2 v L L] i
capabilities to Sirius Web, enabling teams to collaborate efficiently on the L A

same modeling projects

Request a Quote
is an open-source technology that dramatically reduces the

time and effort required to create domain-specific modeling
l ‘ . workbenches
* Sirius Web is the web-based version of Sirius, enabling the development
of modeling studios that can be deployed to the cloud and accessed
through a web browser.

Obeo Enterprise for Sirius is a comprehensive set of complementary

features that extend Sirius Web for enterprise-grade collaboration and

scalable deployment in professional environments.

Features

Control who can connect
Welcome to Obeo Cloud Platform

With Obeo Enterprise for Sirius, only users authorized by the administrator

ron arrpce tho hnctod nrnijortc and thoir cantained meodaelc
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Obeo Enterprise for Sirius

Extension for Sirius Web based applications

Authentication (login + password, OAuth2)
Authorization (private projects, team based access control, ...)

Webhooks

And more

/
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Thank you for watching!



Questions?
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